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Controlling Your Inbox 
A Guide to Keeping Under your Assigned Outlook Quota 

 
Introduction 
 
With the popularity of e-mail as a communications and file sharing tool, it is very easy for anybody to find 
themselves over the preset SUNY System Administration Outlook quota limit.  
 
This guide is intended to help you better manage e-mail messages so that you can retain important e-mail 
communications while still remaining under the preset mailbox quota. The following guide will discuss: 
 

• Outlook Is Not a Permanent Storage Device 
• Creating an Archive Folder in Outlook 
• Using an Archive Folder 
• Using the Mailbox Cleanup Tool 
• The Problem with Pretty Pictures 

 
Outlook Is Not a Permanent Storage Device 
 
E-mail itself was designed as a tool for communications and was never intended to be a long term document 
storage device. Using Outlook this way can lead to severe consequences.  
 
The most dangerous is the possibility of losing all your work done to a document attached to an e-mail message. 
For example: 
 

I receive an e-mail from Bob. This e-mail contains a word document that Bob would like me to work 
on. I open the document from the e-mail and start working. I finish working on the document for the day 
and click on the “Save” icon in Word. The next day I open the document from the e-mail only to find 
that all of the changes that I had made are now gone. Hours of my work have been lost and there is no 
way for me to get them back. 

 
The reason these changes were not saved is that when an attached document is opened from within an e-mail 
message, Outlook creates a temporary file in a temporary directory on your hard drive. Once Outlook is closed, 
or the PC is shutdown, or after a certain time period, these temp files are deleted. 
 
Be sure to save attachments to the My Documents folder on the Y: drive, if you intend to make changes to that 
document. If the document is opened directly from the e-mail message, click on the File menu and then select 
Save As. This will allow you to save the document in any folder.  
 
Creating an Archive Folder in Outlook 
 
One of the easiest ways to keep your Inbox under the quota limit while still holding onto necessary e-mails is to 
create an Archive Folder.  
 
Archive Folders allow you to still access, reply-to and forward e-mail from within Outlook but keep these e-mails 
from using up your limited quota space.  
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It is important to keep in mind that there are two drawbacks to using Archive Folders: 
 

• First, any e-mail that is placed within an archive folder will only be accessible on your work 
computer. In other words you will not be able to access your Archive Folders from Outlook Web 
Access (OWA).  

• Secondly, if you choose to store your Archive Folder on your Y:\ drive (which User Services highly 
recommends), it will count against your Y:\ drive quota. 

 
To create an Archive Folder, please follow these steps: 
 

1. Click on Tools menu and then click on E-mail Accounts. 
 

 
 

2. This will bring up the E-mail Accounts options window. Make sure that View or change existing e-
mail accounts is selected and click on the Next button. 
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3. This will bring you to a window that lists all of the existing accounts that you have access to. Locate 
the Deliver new e-mail to the following location: area. Please check to make sure that you name is 
listed in the dropdown box and click on the New Outlook Data File… button. 

 

 
 

4. This will open the New Outlook Data File window. Locate the Types of storage section and make 
sure that Personal Folders File (.pst) is selected. Now click on the OK button. 

 
 

5. Outlook will now open a Save box asking you to Create or Open Outlook Data File. The default 
location for this file is Y:\EXCHANGE. It is recommended that all Archive Folders be stored here. 
Type in a name for the Archive Folder Data File (i.e. Archive.pst) and click on the OK button. 
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6. Once you have chosen a place to store the Archive Folder, you will be prompted to setup a few basic 
options on the file. You may wish to change the Name of the Archive Folder from Personal Folders to 
Archive for two reasons: 

 
• One, this will allow you to setup several of these Archive Folders and categorize them if you 

choose. 
• Two, Outlook’s Folder List is alphabetical so this will place your Archive Folders at the top 

of this list. 
 

Please leave the compression settings alone. Your Archived Folders can only be accessed by you. It is 
also recommended not to setup a password. If you forget the password no one will be able to access 
your archive folder.  To finalize the Archive Folder setup click on the OK button. 

 

 
 

7. This should bring you back to the E-mail Accounts options window. Click on the Finish button and 
your Archive Folder will be all set.  

 
Using an Archive Folder 
 
Once you have created an Archive Folder you can start moving important e-mail messages from your Inbox to 
clean up your Inbox and resolve any quota issues that you might be experiencing.  
 

1. The first step in moving e-mail messages to an Archive Folder is to select one or more messages from the 
current list.  

 
Note:  To select multiple e-mail messages hold down the Ctrl key when you click on the messages. 
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2. Once you have selected the e-mail message(s) you wish to move to the Archive Folder, click on the Edit 
menu and select Move to Folder…. 

 

 
 

3. When you click on Move to Folder… it will bring up the Move Items window. You will want to locate 
the Archive Folder in the Move the selected items to the folder: section.  
 
Note: This is an alphabetized list so if you named your Archive Folder “Archive” it will be listed towards 
the top. 
 
Click on the + sign next to the Archive Folder to expand the folder to show subfolders. 
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4. If this is your first time using the Archive Folder or you would like to create a new subfolder please read 
on, otherwise you can skip down to step 6. It is often very useful to create various subfolders in your 
Archive Folder so that you can sort stored e-mail messages. This makes them very easy to manage when 
the time comes to find a saved message. To create a subfolder select the Archive Folder in the Move 
Items window and click on New… . 

 

 
 

5. Once the Create New Folder window is open you will need to provide a name for the new folder. 
Choose a name that adequately describes the messages you wish to store in the subfolder. After you have 
chosen a name make sure that the Archive Folder is selected under Select where to place the folder:. 
Once everything is all set, click on OK to create this subfolder. 
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6. To move the e-mail message(s) that you have selected to a subfolder under your archive folders you need 

to select the appropriate subfolder listed in the Move Items window and click on OK. If you do not see 
any subfolders listed please make sure that you have click on the + sign next to your Archive Folder to 
expand it’s listing. If you still do not see any subfolders or would like to create a new subfolder please 
refer back to steps 4 and 5 above. 

 

 
 

7. The e-mail message(s) that you had selected should no longer be displayed in the folder you are back in 
now. You should always check to make sure that the message(s) have been moved into the proper place in 
your Archive Folder. To do this, simply browse to your Archive Folder in your Folder List and check to 
see if the message(s) are under the subfolder you had selected. 

 

 
 
Using the Mailbox Cleanup Tool 
 
The Mailbox Cleanup tool is a very powerful tool you can use to keep your Inbox under its assigned quota. 
Mailbox Cleanup will allow you to find which folders are using the most space, find e-mail that may have large 
attachments, find e-mail older then a specified number of days, and even setup an AutoArchive schedule to move 
old e-mail to your archive for you. 
 
Opening the Mailbox Cleanup Tool: 
 
The Mailbox Cleanup tool comes installed by default on all of the computers here at Systems Administration. To 
open this tool please follow the steps below: 
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1. Click on the Tools menu and then click on Mailbox Cleanup. If you do not see the Mailbox Cleanup 
option under Tools please locate the double-down arrows at the bottom of the Tools menu and click on 
them. This will expand the Tools menu to its full listing and you will be able to find Mailbox Cleanup 
about halfway down the list. 

 

 
 

2. This should open up the Mailbox Cleanup main window below. 
 

 
 
Finding Which Folders Are Using the Most Space: 
 
Once you have opened the Mailbox Cleanup tool it is easy to find which of your folders might be using a large 
amount of your e-mail quota. Locate and click on the button labeled ’Click Here’ to see the size of your 
mailbox. This will open the following window allowing you to see the total size of each of your Outlook folders. 
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Finding E-mails with Large Attachments: 
 
While it is helpful to know which folders are using the most space, it doesn’t always tell you where your large e-
mails are. The Mailbox Cleanup tool allows you to search for an e-mail that is above a user defined size. To do 
this follow the steps below: 
 

1. Once the main Mailbox Cleanup windows make sure that the Find items larger than… option has been 
selected. You may now set the size by either typing an amount in or using the provided up/down arrows. 
(Please note that User Services does not recommend setting this size to be any higher than 250 unless you 
have a specific need to find a small amount of extremely large files.) Once you have set the size simply 
click on the Find… button and Outlook will begin its search. 

 

 
 

2. After the Mailbox Cleanup tools has finished searching Outlook for files the results will be displayed at 
the bottom of the Advanced Find window. Not only will you be able to see the subject and who sent you 
the large e-mail, but the folder in which the e-mail is located and the size of the e-mail will also be shown. 
From this list you may right-click on any of the e-mails listed and select Move to Folder… and move 
them to an archive folder as described above in the “Using an Archive Folder” section or simply delete 
these e-mails from Outlook all together. 
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Finding E-mail Older Then a Specified Age: 
 
Finding an e-mail older then a specified age is as easy as finding e-mails with large attachments. The steps are 
almost exactly the same except you choose the Find e-mails older than… option instead of the Find e-mails 
larger than… The results will display in the Advanced Find window and you will be able to move or deleted 
them the same as you were able to above. 
 
Using AutoArchive to Automatically Move E-mails: 
 
Outlook contains the ability to automatically archive e-mails based on a schedule that you setup. This feature 
takes a lot of the work out of managing your Outlook quota. While this feature is very convenient and quite 
useful, it is also has several pitfalls that can cause you to permanently delete many of the e-mails you are 
attempting to backup. For this reason, User Services advices that you contact the Helpdesk at x1208 or 
helpdes@suny.edu for assistance in setting up an AutoArchive schedule.  
 
When you put in this request one of our Helpdesk staff will setup a time to visit you and work with you to create 
this AutoArchive schedule. If you have any questions about the AutoArchive process please do not hesitate to 
contact the Helpdesk and any one of our staff will be happy to assist you. 
 
Watch Out For Deleted Items: 
 
The Deleted Items folder is one folder that many users find is eating up a lot of quota space. Deleted Items acts 
much the same as the Windows Recycle Bin in that when items are deleted they are really moved into Deleted 
Items instead of removed permanently. This behavior acts as a safeguard against removing important files 
unintentionally.  
 
However, e-mails in Deleted Items were most likely removed because they are no longer needed and/or wanted. 
Because of this, it is usually a good idea to empty the Delete Items on a regular basis to keep Outlook under your 
quota limit. To empty Deleted Items simply locate the button marked Empty under the Deleted Items section of 
the Mailbox Cleanup tool. 
 

 
 

 Created by:  Adam Dodge                                                                                                                    
 Created on: 11/03/05  

mailto:helpdes@suny.edu


 User Services  

 Revised: 11/14/05                                                                                                                   Page 11 of 11 
 Created by:  Adam Dodge                                                                                                                    
 Created on: 11/03/05  

Help Desk: 
(518) 320-1208

 
The Problem with Pretty Pictures 
 
It should be noted that SUNY System Administration e-mail address have been provided for work related 
purposes only. While sharing pictures of family and friends through your e-mail address is not likely to result in 
any official reprimand, there are two things that need to be remembered about e-mails with picture attachments: 
 

• First, most times the images that get attached to e-mails have not been compressed in any way. This 
means that these images tend to be extremely large files which can quickly eat up quota space.  

 
• The second thing to remember is that when dealing with quota space issues, LAN services will require all 

non-work related e-mails be removed from Outlook before any further action be taken.  
 
The best way to deal with this type of e-mail is to save any pictures to your computers C: drive, if you wish to 
save them, and/or delete these messages after viewing. (Remember to empty Deleted Items as well!)  
 
Conclusion 
 
This has been a brief guide to help you stay under your assigned quota limit. It has been our hope that by 
following the above steps you will be able to enjoy unrestricted e-mail usage here at SUNY System 
Administration. If you have any questions about the information contained within this guide, or any questions on 
computer use in general, please do not hesitate to contact the Helpdesk at x1208 or helpdesk@suny.edu. It will be 
our pleasure to help in any way that we are able. 
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